Contents

1. Scripting Concept ................................................................. 3
2. The Script Runner Tool ...................................................... 5
3. Installing Script Runner ........................................................ 6
4. Configuring Script Runner .................................................. 7
5. The Run Script Task ............................................................. 9
6. Scripting on Mac OS ............................................................. 11
   6.1 AppleScript - Example 1 .................................................. 11
   6.2 AppleScript - Example 2 .................................................. 14
   6.3 Shell Script - Example ................................................... 18
7. Scripting on Windows .......................................................... 22
   7.1 Windows Script Example 1 .............................................. 22
   7.2 Windows Script Example 2 .............................................. 24
   7.3 Batch File Example ....................................................... 28
8. Using ExtendScript (Mac & Windows) .................................. 33
   8.1 Adobe Applications on Windows: Run Script Runner as an Application (Not as a Service) ........................................... 33
   8.2 ExtendScript in Adobe Illustrator - Example 1 .......................................................... 33
   8.3 ExtendScript in Adobe Illustrator - Example 2 .......................................................... 36
   8.4 ExtendScript in Adobe Photoshop - Example .......................................................... 39
9. Script Samples ........................................................................ 41
1. Scripting Concept

Automating Desktop and Other Applications

Although Automation Engine already offers a broad set of tools to create custom workflows, it is still possible that you miss some functionality or that the available functionality does not support the native graphics format that you want to run them on.

This is why Automation Engine also offers custom scripting: you can write scripts (small programs) that typically represent actions that operators do interactively in their graphic desktop applications.

Once you created that script, the Run Script task enables to insert that task into your normal workflows. This is how you can automate your desktop applications.

Some examples:

- To automate actions in desktop applications like Adobe Illustrator, Photoshop, InDesign (Server), etc. (via ExtendScript on Mac Os and Windows).
- To convert files into a format that Automation Engine tasks support. For example converting non-PDF compatible AI files into PDFs.

Attention: It is up to the user to verify that his intended use of the offered automation functionality is compliant with any third party license agreement and/or other restrictions applicable to any non-Esko products.

Supported Script Types

- AppleScript (Mac)
- ShellScript (Mac)
- Batch files (Windows)
- Windows Script (VBScript, JScript) (Windows)
- ExtendScript (Mac and Windows)

Attention: When scripting Adobe applications, the Script Runner tool on Windows does no longer support 32 bit versions of those applications.

The Script Runner Tool

Executing such scripts starts in the Run Script task. One of the settings in that task is to choose if the script will be executed by a separate Script Runner tool (that you installed earlier on a Mac or Windows client computer), or if the script can run on the Automation Engine server itself (in an on-board 'script runner').

When, for example, your script is a Windows batch file, it will be possible to run it on the Automation Engine server itself. But when the script needs to interact with a Mac (Adobe) application, it will require help from a standalone Script Runner that you also installed on that Mac.

Learn more in The Script Runner Tool on page 5.
Extra Information and Tips available as KB articles

Because the area of scripting is often about customization, the examples in this documentation do not cover all use cases.

We therefore advise to also check *Esko's Knowledge Base* for articles on this topic.
2. The Script Runner Tool

The Automation Engine does not actually run your custom script: the task communicates with an Automation Engine Script Runner.

**Attention:** As mentioned in *Scripting Concept*, the ‘Run Script’ task can run the script on the AE server itself (a Windows Script or batch file) or it could use a standalone Script Runner tool on a Mac or Windows client.

Here’s an overview of the workflow when a standalone Script Runner tool is used:

1. The **Run Script** task sends a request to run the selected script on its input file(s). The task can communicate optional script parameters and also defines the output folder for the resulting file(s).
2. The selected **Script Runner** processes the request and runs the script.
3. The **Script Runner** sends the results back to the Run Script task.
4. The workflow continues with the outputs from this Run Script task.
3. Installing Script Runner

Follow these steps to install the Script Runner tool:


2. After downloading, double-click the ‘dmg’ file (Mac) or the ‘exe’ file (Windows) to start the installation. Follow the instructions in the Assistant (Mac) or Installshield Wizard (Windows).

3. Check the tool's preferences to make sure it is running on that computer:
   - On Windows, open Start > All Programs > Esko > Automation Engine Script Runner > Preferences.

   In the Script Runner Preferences dialog, you can:
   - **Start / Stop** the Script Runner (or just check if it is running).
   - **Enable / disable Start at login**
   - **View / change** the Port that the Script Runner is communicating with
   - **View / change** the default folders for (types of) scripts.

   Example (on Windows):

   ![Script Runner Preferences dialog](image)

   **Note:** On Windows, this will run the Script Runner as a 'Service'. Learn about (the need for) other methods in Adobe Applications on Windows: Run Script Runner as an Application (Not as a Service) on page 33.

   - **Attention:** The above shown folders are local, on the Script Runner computer. Learn how you can (also) store them centrally in Configuring Script Runner on page 7.
4. Configuring Script Runner

The Automation Engine server needs to know where your Script Runner tool(s) were installed. You could for example have 2 Macs dedicated to run scripts and also have the Automation Engine server itself have some Windows scripts or batch files running.

1. Install Script Runner on the client computers that will run scripts. Learn more in Installing Script Runner on page 6.
2. In a Pilot, go to Tools > Configure.
3. Go to the category Scripts.
4. Now define which computers will run the scripts. Press Insert or choose File > New to add one.

5. Give a suitable name to that Script Runner. Press F2 or choose File > Rename
6. In the Host field, enter the computer name or IP address of the Script Runner computer.
7. Enter the Port used to connect this computer to your Automation Engine server.
   By default, this is 1983.
8. Click Test Connection. You should now see a list of all available scripts on that computer or see a message 'No scripts available'.
   These are the scripts that the Run Script Task will let you choose from when you have selected that Script Runner configuration.
You can store script on a local (Script Runner) client or centrally on the Automation Engine server:

- **Local**: You can store scripts on your local client computer on the folder specific for script type. But note that Automation Engine does not back up these local scripts. It can be useful however to only have them local when you are still writing and testing a script or when you do not intend to give access to other Script Runners in your network.

  **Note**: The default location on a client computer is `/Library/Scripts/Esko` (Mac) and `C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts` (Windows).

- **Central**: Alternatively, you can store your scripts in a central Automation Engine system folder. This option is suitable when you want to make your scripts available to all configured Script Runners. They will then also be part of your Automation Engine backup.

  **Note**: The default location on the AE server is `C:\Esko\bg_data_fastserver_v100\Scripts`. The subfolder names indicate the type of script.

9. Choose **Save** (from the menu of the Configure panel).

10. Select the Configure category **Scripts** (not a configured item, but one level higher). On this level you see a dialog where you can choose **Download Scripts** to download all scripts from all configured Script Runner tool(s) and centralize them onto the Automation Engine server. This is done to have a central library that will also be part of your server configuration backup.

  **Note**: You will be asked to confirm when local scripts would overwrite central ones.
5. The Run Script Task

**Note:** Learn about the concept and the setup of custom scripts in *Scripting Concept* on page 3.

This task contacts a *Script Runner tool* to run a script on the input file(s).

1. **Run on:** Choose the *Script Runner* item that you configured in the Configure panel.
2. **Select the Script Type.** The types are different, depending if the selected Script Runner runs on a Mac or a Windows computer:
   a) For Mac: You can choose from *AppleScript*, *Shell Script* and *ExtendScript*.
   b) For Windows: You can choose from *Batch File*, *ExtendScript*, *Windows Script* and *Windows Script*.
   
   From version 16.1, you can only install the Script Runner tool on a 64 bit host, but you can still run 32bit Windows scripts by specifying the script type as 'Windows Script (32 bit)'.
3. **Select the Application.** This field helps to find the right application, especially when you have multiple versions installed. The drop down list is a default list that you can edit.
   - On Mac: this is the (original) name of the .app file of that application
   - On Windows: the "Target location" that appears when you ask the "Properties" of that application. An example:
**Tip:** It is possible that you do not have to enter the full name, but minimally the part that will help the task to recognize which of the multiple versions you want. For example when you both have a CS and a CC version, then the year and the bit version do not have to be mentioned extra (because those are only mentioned after the ‘CS’ or ‘CC’ part).

4. Select the **Script File**. You can select one from the drop-down list, enter a path or/and use SmartNames.

5. When the script needs one or more optional parameter(s), enter them in **Script Parameters**. Click **Add** and type the parameter.

**Note:** Learn more details and see some examples in the next pages.
6. Scripting on Mac OS

A Script Runner on Mac OS supports AppleScript and Shell Script to automate operations.

Note:
Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These scripts are solely intended to demonstrate techniques for accomplishing common tasks. Additional script logic and error-handling may need to be added to achieve the desired results in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is compliant with any third party license agreement and/or other restrictions applicable to any non-Esko products.

6.1 AppleScript - Example 1

AppleScript is a scripting language that enables direct control of script-able applications and of many parts of the Mac OS. An AppleScript-able application is one that makes its operations and data available in response to AppleScript messages, called Apple events.

We recommend using AppleScript because:

• it is highly integrated into the Mac OS
• it is supported by a lot of third party applications
• it very accessible to scripting beginners.

1. Open the AppleScript Editor and add following code:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>main</td>
<td>This function will be called by the Script Runner. Only the code in this main function gets executed.</td>
</tr>
<tr>
<td>inputs</td>
<td>The first argument of the main function: a list of input file paths (type: list of strings).</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>outputFolder</td>
<td>Second argument of the main function: the folder where AE expects the script's result files. AE will continue the flow with the files you write in this folder. If you leave this folder empty, AE will continue the flow with the inputs of the Run Script task (type: string).</td>
</tr>
<tr>
<td>params</td>
<td>Third argument of the main function: additional script parameters injected into the script via the Run Script ticket (type: list of strings).</td>
</tr>
<tr>
<td>log</td>
<td>Extra log information in the Run Script task details.</td>
</tr>
<tr>
<td>return “OK”</td>
<td>This will communicate to the Run Script task that everything went fine. Other possibilities are return “Warning” and return “Error”.</td>
</tr>
</tbody>
</table>

2. Save this code as an AppleScript text file in the Script Runner's AppleScript folder (default: /Library/Scripts/Esko/AppleScript) or in the Automation Engine AppleScript folder.

![Image of AppleScript Editor](image)

**Note:** Script Runner supports ‘Text’ format. Therefore it is essential to change the file format to ‘Text’.

3. You can add following code to test this script locally in the AppleScript Editor. Save the file and click Run to execute the script.
4. In the Pilot, go to **Files** view where you can select a file and open a **New Task**. Choose the **Run Script** task, modify its settings and launch the task.

Notice the ‘Hello, World!’ and ‘OK’ result in the event log. The Script Runner does not interpret the test code in your script. It will execute the contents of the main function and ignore the rest. You can keep any test code for future local testing.
Learn more in *The Run Script Task* on page 9.

Note that the ‘Hello, World!’ in the task details and ‘OK’ state correspond with \texttt{log “Hello, World!”} and \texttt{‘return “OK”’} in the script.

### 6.2 AppleScript - Example 2

In this example, we use AppleScript to copy every input file with a size smaller than the size specified in the script parameters to the output folder. To do that, we use \texttt{inputs}, \texttt{outputFolder} and \texttt{params} in the AppleScript.

First, we illustrate how to duplicate files without the size restriction and then we proceed with the actual case.

1. Open the AppleScript Editor and add the below shown code. This code is aimed to iterate through the list of inputs. It enables you to handle the inputs one by one, via the ‘input’ variable.
2. You can modify the script as shown below to duplicate the files to a specified output folder without size restrictions. Save this code as an AppleScript text file in the default AppleScript folder of Script Runner (default: `/Library/Scripts/Esko/AppleScript`) or in the Automation Engine AppleScript folder.

3. Add the file size check in the code as shown below. This will duplicate the file when the input file size is smaller than the maximum size from the script parameters. If this condition is not met, it will add an entry in the log and there will be "Warning". Save the file.
4. In the Pilot, go to Files view, select the files to be copied and open a **New Task**. Choose the **Run Script** task, modify its settings and launch. This modified ticket will duplicate every selected file which is smaller than 10MB to the current job's Script Output folder. In this example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).
‘SmallLabel.pdf’ is duplicated into the job’s ‘ScriptOutput’ folder. ‘BigBox.pdf’ was too big to duplicate (> 10MB). Therefore, the task ended in a ‘Warning’ state and added an entry in the task details.
6.3 Shell Script - Example

In this example, we use a Shell Script to copy every input file with a size smaller than the specified size in the script parameters to the output folder.

1. Open a text editor and add the below shown code. When the Script Runner executes this code, $1 (the script's first argument) will contain a string of input file paths separated by : . The code splits up the concatenated file paths into a real list. This helps to iterate through the list and handle the Run Script task's inputs one by one.

```
#!/bin/bash

# Split up the input file paths into a list
# via the Internal Field Separator (IFS)
OLDIFS=$IFS # Always keep the original IFS
IFS=':' # Now set it to ':
IFS=' $1' # Split up '$1' into the 'inputs' variable, with ':' as separator
inputs=($1)
IFS=$OLDIFS # Restore the original IFS

inputCount=${#inputs[@]}

# Iterate through the list of inputs
for (( i=0; i<$inputCount; i++ ));
done

# Add code here to handle each input

exit 0
```

2. Write the code as shown below. This script copies the input to the output folder if the input's file size is smaller than the maximum size from the script parameters. If the size of the file is bigger, it adds an entry in the log and makes sure the task ends in 'Warning' state (via exit value '1'). Save this code as a text file to the Script Runner's Shell folder (default: /Library/Scripts/Esko/Shell) or to the Automation Engine Shell folder.
$1$ | First Shell Script argument: the Run Script task's inputs. A string of input file paths, separated by `:`.

$2$ | Second Shell Script argument or output folder: This is the folder where Automation Engine expects the script's result files. AE will continue the flow with the files you write in this folder. If you leave this folder empty, AE will continue the flow with the inputs of the Run Script task.

$3, 4, 5, ...$ | Remaining Shell Script arguments: additional script parameters which you can inject into the script via the Run Script task.
3. In the Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task, modify its settings and launch. This modified ticket will duplicate every selected file which is smaller than 10MB to the current job's Script Output folder. In this example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

‘SmallLabel.pdf’ is duplicated into the job’s Script Output folder. ‘BigBox.pdf’ was too big to duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state (due to $exitValue=1$ in the code) and added an entry in the task details.
Automation Engine
7. Scripting on Windows

A Script Runner on Windows supports Windows Scripts and Batch files. We recommend Windows Script for its scripting abilities comparable to batch files, its wider range of supported features and the simpler syntax. Windows Script is plain-text VBScript or JScript which is interpreted and run by the Windows Script Host.

**Note:** Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These scripts are solely intended to demonstrate techniques for accomplishing common tasks. Additional script logic and error-handling may need to be added to achieve the desired results in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is compliant with any third party license agreement and/or other restrictions applicable to any non-Esko products.

7.1 Windows Script Example 1

1. Open a text editor and add the below shown code:

   ```vbscript
   Function Main
   The function that will be called by the Script Runner. Script Runner executes only the code in this main function.
   inputs
   First argument of main function: a list of input file paths (type: list of strings).
   outputFolder
   Second argument of the main function: the folder where AE expects the script's result files. AE will continue the flow with the files you write in this folder. If you leave this folder empty, AE will continue the flow with the inputs of the Run Script task (type: string).
   ```
params | Third argument of the main function: additional script parameters injected into the script via the Run Script ticket (type: list of strings).

WScript.Echo | This puts some extra log info in the Run Script task details and log. This call prints text to the Console and adds a newline character without Script Runner context.

Main = “OK” | This communicates to the Run Script task that everything went fine. Other possibilities are Main = “Warning” and Main = “Error”.

2. You can test this script locally by adding the code shown below. Save this file. Open command prompt. Change the directory to the script's parent directory. Run command 'cscript MyHelloWorld.vbs'.

![Image of Visual Basic code]

This will produce the output ‘Hello, World!’ to the console. The Script Runner does not interpret the test code in your script. It will execute the contents of the main function and ignore the rest. You can keep your test code for future local testing.

3. In a Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task, modify its settings and launch the task.
Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with WScript.Echo “Hello, World!” and Main = “OK” in the script.

7.2 Windows Script Example 2

In this example, we use Windows Script to copy every input file with a size smaller than the size specified in the script parameters to the output folder. We use inputs, outputFolder and params in the script to achieve our objective.

First, we illustrate how to duplicate files without the size restriction and then we proceed with the actual example.

1. Open a text editor and add the below shown code. This code is aimed to iterate through the list of inputs. It enables you to handle the inputs one by one, via the ‘input’ variable.
2. You can modify the Script as shown below to duplicate the files to a specified output folder without size restrictions. Save this code as a text file with '.vbs' extension (VBScript) in the Windows Script folder of Script Runner (default: C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\WindowsScript) or in the Automation Engine WindowsScript folder.
3. Add the file size check in the code as shown below. This will duplicate the file when the input file size is smaller than the maximum size from the script parameters. If this condition is not met it will add an entry in the log and there will be "Warning". Save the file.
4. In a Pilot, go to Files view, select the files to be copied and open a **New Task**. Choose the **Run Script** task, modify its settings and launch. This modified ticket will duplicate every selected file which is smaller than 10MB to the current job’s ‘ScriptOutput’ folder. In this example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).
‘SmallLabel.pdf’ is duplicated into the job’s ‘ScriptOutput’ folder. ‘BigBox.pdf’ was too big to duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task details.

7.3 Batch File Example

1. Open a text editor and add the below shown code. This code is aimed to iterate through the list of inputs. It enables you to handle the inputs one by one, via the command %1 (the script's first argument) will contain a string of input file paths, separated by ‘;’.
2. You can modify the Script as shown below to duplicate the files to a specified output folder with a size check. Save this code as a text file with '.bat' extension in the Script Runner Batch File Folder (default: `C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\BatchFile`) or in the Automation Engine 'BatchFile' folder.
%1 First batch file argument: the Run Script task's inputs. A string of input file paths, separated by `;`.

%2 Second batch file argument or output folder: the folder where AE expects the script's result files. AE will continue the flow with the files you write in
this folder. If you leave this folder empty, AE will continue the flow with the inputs of the Run Script task.

| %3, %4, %5... | Remaining batch file arguments: additional script parameters, injected into the script via the Run Script task. |

<table>
<thead>
<tr>
<th>Exit value</th>
<th>Ending Status of the task</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>OK</td>
</tr>
<tr>
<td>1</td>
<td>Warning</td>
</tr>
<tr>
<td>2</td>
<td>Error</td>
</tr>
</tbody>
</table>

3. In a Pilot, go to Files view, select the files to be copied and open a New Task. Choose the Run Script task, modify its settings and launch. This modified ticket will duplicate every selected file which is smaller than 10MB to the current job's Script Output folder. In this example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

‘SmallLabel.pdf’ is duplicated into the job’s ‘ScriptOutput’ folder. ‘BigBox.pdf’ was too big to duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task details.
Automation Engine
8. Using ExtendScript (Mac & Windows)

8.1 Adobe Applications on Windows: Run Script Runner as an Application (Not as a Service)

When you use ExtendScript on Windows, you can avoid troubles while accessing your user specific settings such as Adobe applications' Presets, Actions etc. by stopping the Script Runner service and running it as an application for the logged in user (who also defined the Adobe settings).

Follow these steps to do this:

1. Open Start > All Programs > Esko > Automation Engine Script Runner > Preferences.
2. Stop the Script Runner and deselect Start at login (which actually means ‘Start as service’) and Close Preferences.
3. Start it as a console application by double clicking its executable in the Script Runner’s program folder >\bin_ix86\egscrrun.exe. For example C:\Esko\bg_prog_fastserverscrrunnt_v141\bin_ix86\egscrrun.exe

8.2 ExtendScript in Adobe Illustrator - Example 1

ExtendScript is JavaScript extended for Adobe CS/CC applications. Adobe provides the ExtendScript Toolkit (ESTK): a complete IDE (integrated development environment) to program ExtendScript. Learn more about Adobe scripting resources in the Adobe Scripting Center.

Attention: As mentioned in the introduction, Adobe (Windows) 32 bit applications are no longer supported on a standalone Script Runner tool.

1. Open the ExtendScript Toolkit and add the below shown code. Save this code in the Script Runner’s ExtendScript folder. The default location is : /Library/Scripts/Esko/ExtendScript for a Script Runner on Mac or C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts \ExtendScript on Windows. Alternatively, you can save them in the ExtendScript folder of Automation Engine.
Main

This function will be called by the Script Runner. Only the code in this main function gets executed.

Inputs

First argument of main function: a list of input file paths (type: list of strings).

outputFolder

Second argument of the main function: the folder where AE expects the script's result files. AE will continue the flow with the files you write in this folder. If you leave this folder empty, AE will continue the flow with the inputs of the Run Script task (type: string).

params

Third argument of main function: additional script parameters, injected into the script via the Run Script ticket (type: list of strings).

$.writeln

This writes extra log information in the Run Script task details and log. Without Script Runner context this call prints text to the Console, and adds a newline character.

alert

This registers some extra log info in the Run Script task details and log. Without Script Runner context this call displays an alert box.

return "OK";

This communicates to the Run Script task that everything went fine. Other possibilities are Return = "Warning" and Return = "Error".

2. To test the script locally in the ExtendScript Toolkit, add below shown code, save and run the script.
As a result, ‘Hello, World!’ and ‘OK’ are shown in the Console and the alert box pops up:

The Script Runner does not interpret the test code in your script. It will execute only the contents of the main function and ignore the rest. You can keep your test code for future local testing.

3. In the Pilot, go to **Files** view, select a file and open a **New Task**. Choose the **Run Script** task, modify its settings and launch the task.
Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with
$.writeln("Hello World!") and Return = “OK” in the script.

8.3 ExtendScript in Adobe Illustrator - Example 2

Note: Make sure you read this page first: Adobe Applications on Windows: Run Script
Runner as an Application (Not as a Service) on page 33.

Note: To prevent having to start up the Script Runner every time you log in, add its executable
to your user’s/system’s Startup Items.

1. Define a My Print Preset in your Adobe Illustrator application.
2. Open the ExtendScript Toolkit and add the below shown code. This code is aimed to iterate
through the list of inputs. It enables you to handle the inputs one by one, via the input
variable.
3. To print every input file using a **Print Preset** from the script parameters in the **Run Script** task, write the code as shown below. Save this code in the default ExtendScript folder (of Script Runner or of Automation Engine).
4. In a Pilot, go to **Files** view, select a file and open a **New Task**. Choose the **Run Script** task, modify its settings and launch the task.
Launching this ticket will print the selected Illustrator files using the **Print Preset** specified as script parameters (*My Print Preset*) in the task.

### 8.4 ExtendScript in Adobe Photoshop - Example

**Note:**

Sample scripts are solely intended to demonstrate techniques for accomplishing common tasks. Additional script logic and error-handling may need to be added to achieve the desired results in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is compliant with any third party license agreement and/or other restrictions applicable to any non-Esko products.

In this example, we illustrate a script that performs a Photoshop "action" and then produces a JPEG output. The script 'EskoPSDoActionAndSaveasJPG.jsx' is available from the sample scripts subfolder "ExtendScript" in `/Library/Scripts/Esko` (Mac) or `C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts` (Windows).

1. You have to save the **Set** and **Action** in Photoshop. In this example we are using an action named "Molten Lead" which is one of the "Default Actions" (folder) as **Set** (variable 2) and "Molten Lead" as **Action** (variable 1).

2. You can open the script with ExtendScript Toolkit to edit the script if required. However, in this sample, we do not need to edit the script.
3. Edit the settings of the **Run Script** task as shown below:

   ![Run Script Settings](image)

   a) **Run on**: is the name of the computer where your Automation Engine ScriptRunner is installed. The name in this example is *ShaletMac*. Learn more about configuring and naming a Script Runner in *Configuring Script Runner* on page 7.

   b) **Script Type**: choose *ExtendScript*.

   c) **Script File**: choose *EskoPSDoActionAndSaveAsJPG.jsx*.

   d) **Script Parameters**: Add the name of your Photoshop Action name followed by your **Set**. In this example, *Molten Lead; Default Actions*

   e) Save the task ticket.

4. Launch the task:
   a) Select a Photoshop file.
   b) Right-click the file and browse for the ticket.
   c) Click **Launch**.

You will see that while the script starts to run on the Automation Engine Server, Photoshop opens, performs the actions, closes and continues the script. The result of this sample script is an adjusted jpeg.
9. Script Samples

Click this link to download a PDF containing some samples of scripts.